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System Overview 
 

ACAFM is an intermittent contact mode of atomic force microscopy (AFM) in which the cantilever is 
driven by an alternating current (AC).  The AC Mode option, added to the PicoLE system, allows the user 
to image softer or more fragile samples than is possible with normal contact mode AFM.  The Molecular 
Imaging MAC Mode Controller can operate in two different modes; magnetic AC (MAC) and acoustic AC 
(AAC).  In MAC mode, the alternating current running through a coil creates an alternating magnetic field.  
The field drives the cantilever via a magnetic coating on the back of the cantilever.  Typical MAC 
frequencies are on the order of 80kHz.  In AAC mode, a voltage that oscillates on the order of 300kHz 
drives a piezo crystal in the scanner nose.  The drive frequency in AAC mode is based on the natural 
resonant frequency of the cantilever and, as such, may vary from cantilever to cantilever.  In MAC Mode, 
the cantilever can be used at frequencies below that of resonance.  At the drive frequency, the tip moves up 
and down with a measurable amplitude when it is unaffected by (distant from) the sample surface.  The 
system detects changes in the amplitude first, as the tip approaches the surface and then, with greater 
pressure, as the tip reaches the surface and atomic repulsion effects become dominant.  An intermolecular 
force versus distance curve is shown in Figure 0.1 below. 

 

Figure 0.1 (Intermolecular force-distance curve) 

When the tip-sample force is attractive, the amplitude increases and when the tip-sample force is repulsive, 
the amplitude is decreased.  The Z-axis piezo adjusts to maintain the setpoint amplitude and, thus, 
generates the topography data as the cantilever is scanned across the sample surface. 
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Chapter 1: Initial Setup 
 

Note: The use of the term AC Mode refers to either MAC Mode® or Acoustic AC® Mode.  The terms 
MAC Mode and Acoustic AC are used only when there is a need to differentiate between the two modes of 
imaging. 

 
List of MAC Mode Components 

 
♦ MAC Mode controller 
♦ Acoustic AC Nose Assembly 
♦ MACleversTM 
♦ AAC Probes 
♦ MAC Mode Sample stage 
♦ DB25 to DB25 – connects AC Mode Controller to Head Electronics Box. 
♦ BNC to BNC – connects AC Mode Controller to Head Electronics Box. 
♦ Power Cable – connects AC Mode controller to power source. 
♦ RS-232 (serial) cable – connects AC Mode controller to computer. 
♦ MAC/EC cable – connects MAC Mode sample stage to microscope base. 
 
Please contact MOLECULAR IMAGING if any of these items are missing. 
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Connections 
See Figure 2.2 in the next chapter to reference the connections described below.  The terms “male” and 
“female” refer to the connector fittings, and not to the pins within the fittings. 

Power Cord 
Insert the power cord supplied with the AC Mode package into the back of the AC Mode controller.  Do 
not power on the controller at this time. 

PicoLE Head Electronics Box Connection 
Connect the female end of one of the DB25 cables to the bottom PICO SPM I connection on the AC 
Mode controller.  Be sure the cable fits snugly and is not loose; if the connection is loose this may cause 
serious problems while imaging. 

After connecting the cable to the AC Mode controller, connect the other (male) end to the 
CONTROLLER connector on the PicoLE Head Electronics box. 

Connect the BNC cable to the MAC port on the AC Mode Controller, making sure the connector twists 
and locks into place, then connect the other BNC end of the cable to the MAC connector on the PicoLE 
Head Electronics box.  Mention AAC to AAC BNC connections for AAC Mode operation. 

If imaging in MAC Mode, the microscope must be connected to the sample plate using the MAC/EC 
cable.  Plug the round jack into the underside of the microscope, and the 6 pin connector into the sample 
plate.  If using Acoustic AC, the signal travels through the normal connections and this connection is not 
necessary. 

Serial Port Connection 
For most users, the AC Mode controller will be controlled using a standard RS-232 serial link.  Connect to 
the computer COM1, COM2, or COM3.  The default is COM1, but this setting can be changed in the 
PicoScan software.  See Advanced under Chapter 3: AC Mode Software Controls below for more 
information. 

PicoScan Controller Connection 
Connect the male end of the other DB25 cable to the top PICO SPM I connector on the AC Mode 
controller.  Be sure the cable fits snugly and that it is not loose; this too can result in serious malfunctions 
while imaging. 

After connecting the cable to the AC Mode controller, connect the other (female) end of the DB25 cable to 
the PICOSPM connector on the PicoScanTM 2100 controller.  If using a PicoScan 2500 or 3000 controller, 
use the connection labeled PICOSPM I. 

Note:   It is not possible to do both MAC Mode and Acoustic AC Mode imaging at the same time. 
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Chapter 2: The AC Mode Controller 
 

The AC Mode controller is the driving force behind AC Mode.  It is here that the drive signal is produced 
and controlled.  After preparing and mounting the sample it is now time to turn our attention to the AC 
Mode controller.  If using an older AC Mode box (with only 25-pin connectors), refer to the original 
manual.  Note that the AC Mode controller must be plugged into the wall. 
 
 

Front Panel 
 

 
 

Figure 2.1 (Front panel of the MAC Mode Controller) 
 

The meter on the front panel displays the amplitude of the cantilever in volts.  To convert it to actual 
amplitude, use this equation: 
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♦ MeterVoltage: The number displayed on the meter. 
♦ InputGain: The input gain setting in the AC Mode Controls window in PicoScan.  See Main under 

Chapter 3: AC Mode Software Controls below for more information. 
♦ Sensitivity: The PicoScan controller pre-amp conversion coefficient.  This is calibrated in PicoScan by 

taking the inverse of the Force vs. Distance contact region slope in contact AFM mode.  If amplitude 
data are crucial, please note that the sensitivity should be recalibrated each time the laser spot is 
adjusted on the cantilever.  See the PicoScan manual for more information. 

 
To calibrate amplitude based on the signal displayed in the software (on the amplitude monitor), use this 
equation: 
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♦ MonitorVoltage: The value displayed on the amplitude monitor in PicoScan. 
♦ S.P.: The amplitude setpoint in the Servo Controls window in PicoScan. 
 
The detector electronics act as a low pass filter with a 3dB point of 320 kHz.  Take this into account when 
calculating high-frequency amplitudes. 
 
 

Rear Panel 
 

 
 

Figure 2.2 (Rear panel of the MAC Mode Controller) 
 
 

MAC 
Drive output for MAC Mode.  Connect to the BNC cable that plugs into the MAC connection on the 
PicoLE Head Electronics box. 

AAC 
Drive output for Acoustic AC.  Connect to the BNC cable that plugs into the AAC connection on the 
PicoLE Head Electronics box. 

Drive In 
This is for an auxiliary input signal to be summed into the AC Mode drive signal. 

Deflection 
Average position of the laser spot on the photodiode.  The AC Mode box generates this signal by putting 
the raw input from the photodiode through a low pass filter. 

Amplitude 
This is the output from the lock-in amplifier representing amplitude.  The signal is the same as the meter 
but the sign is reversed. 
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Phase 
Phase shift of the center frequency component of the input signal.  The conversion factor is 9 degrees per 
volt. 

The Deflection, Amplitude and Phase BNC connections are outputs that can be read through an 
oscilloscope, or through the software by plugging them into the auxiliary input (AuxIn) on the PicoScan 
Controller. 

Serial Port 
Connects the AC Mode box to the computer. 

Aux 
This connector is not currently in use. 

Pico SPM II / Pico SPM I 
These DB44 or DB25 connectors go to the controller and microscope.  The PicoLE microscope uses the 
DB25 (PICO SPM I) connectors. 
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Chapter 3: AC Mode Software Controls 
 

Open the AC Mode Controls window from the View menu in PicoScan.  If the AC Mode Controls 
selection is grayed out, enable it from the Misc. Options tab of the Setup (Scanner, Controller etc.) 
window.  This window can control any PicoSPM I or PicoSPM II AC Mode Controller.  If using an older 
AC Mode Controller, some controls will not appear in the window, as they are controlled on the box itself. 

 
Main 

 
The Main window contains the most-used AC controls.  All values in this window may be changed using 
the text box or the up and down arrows on the keyboard. 

 

Figure 3.1 (The Main AC Mode Controls window) 

♦ Frequency (kHz): Displays the current drive frequency. 
♦ Drive (%): The amplitude of the drive force as a percentage of maximum available.  The On checkbox 

denotes whether the drive is turned on or off (for older controllers, this control is on the box itself as 
well).  The checkbox defaults to checked when PicoScan starts. 

♦ Phase Offset (deg): Allows you to change phase offset. 
♦ Zero Phase: This button zeroes the phase offset and sets the phase signal to zero. 
♦ MAC / AAC: This pulldown menu allows the user to designate which mode (MAC Mode or Acoustic 

AC) is being used.  This menu will only appear if using a PicoPlus AC Mode Controller.  This menu 
defaults to MAC when PicoScan starts. 

♦ Input Gain: The signal into the MAC Mode Controller is multiplied by the factor designated in this 
pulldown menu.  Selecting a higher gain can result in a higher signal to noise ratio for a small signal.  
Do not use a high gain setting with a large amplitude, because any signal outside the range ±10 V is 
clipped. 

♦ Contact / AC Mode: This pulldown menu allows the user to designate contact AFM or ACAFM 
mode.  This menu only appears if a PicoPlus AC Mode Controller is being used.  This menu has the 
same function as the AC Mode button on old AC Mode boxes.  This menu defaults to Contact when 
PicoScan starts in AFM Mode, and AC Mode when PicoScan starts in AC AFM mode. 
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♦ Sweep: Brings up the Amplitude vs. Frequency Spectroscopy dialog. 
♦ Connect: When this button is clicked, PicoScan will attempt to connect to the MAC Mode Controller.  

Use this button to reinitialize the MAC Mode Controller after powering off. 
♦ Advanced: Toggles the window to the Advanced functions. 
 
 

Advanced 
 
The Advanced window contains optional and advanced AC mode settings. 

 

Figure 3.2 (The Advanced AC Mode Controls window) 

♦ Increment Size: These numbers determine the increment size when the up and down arrows on the 
keyboard are used to change Frequency and Drive. 

♦ Filter Thresholds: These controls set the band pass filter of the lock-in amplifier of the MAC Mode 
Controller for different frequencies.  The active band pass filter is the one with the highest threshold 
below the current drive frequency.  It is recommended that the user not change these unless they 
thoroughly understand the theory behind lock-in amplifiers.  Any changes may adversely affect the 
performance of the system. 

♦ Restore: Restores all default settings. 
♦ COM Port Selector: This pulldown menu allows the user to designate into which COM port on the 

computer the MAC Mode Controller is plugged. 
♦ Update: Updates the firmware in the MAC Mode Controller. 
♦ Main: Toggles the window to the Main functions. 
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Chapter 4: MACAFM Tutorial 
 

A strong point of the PicoSPM system is its AC mode capability.  With this mode, one can obtain high-
quality images of soft samples in-situ.  AC mode means that the cantilever oscillates at a controlled 
frequency, and PicoScan measures the resulting amplitude and phase changes as the tip of the cantilever 
interacts with the surface being imaged.  Either an oscillating magnetic field or a vibrating piezo crystal 
induces the cantilever oscillations.  In the case of magnetic excitation (MAC Mode), the cantilever is coated 
with magnetic material, which allows the magnetic field to drive the cantilever.  This tutorial will use MAC 
Mode; however, all the principles are the same for Acoustic AC Mode.  This tutorial will use a Large 
scanner and a Type II MAClever (C ≈ 3 N/m) to image a gold-on-mica substrate.  This tutorial should only 
be done after completion of the AFM tutorial in the PicoScan software manual.  If the images obtained are 
of unsatisfactory quality, try using the PicoIC™ isolation chamber.  This tutorial is written for a system 
with a PicoLE microscope and a MAC Mode Controller. 
 
 

Hardware 
♦ AC Mode controller 
♦ MAC Mode Sample plate 
♦ AFM scanner 
♦ MAC Mode AFM cantilever 
♦ Tweezers 
♦ Sample 
♦ Two-sided tape 
♦ Photodiode detector 
 
 

System Setup 
 

Hardware Setup 
Set up the microscope as detailed in the PicoLE System module.  Make the hardware connections that 
are described in Chapter 1: Initial Setup (page 3) of this module.  Note the MAC/EC cable must connect 
the sample plate to the microscope in order to use MAC Mode.  The Contact/AC Mode/CS AFM 
Switch on the PicoLE Head Electronics Box should be turned to AC Mode.  Be sure to use a MAC 
sample plate, as the magnetic core of the standard sample plate will interfere with the MAC Mode drive 
field.  See Figure 4.1 below. 
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Figure 4.1 (The MAC Mode sample plate has a split in the core that 

prevents the formation of an induced magnetic counter-field) 
 

Software Setup 
PicoScan software should have already been installed on the computer.  Use the following steps as a guide 
to become familiar with the system settings required to make good images. 
 
1. Click View on the main menu bar and select Setup (Scanner, Controller etc.). 
 

 
 

Figure 4.2 

Split in core
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The setup dialog will open to the Scanner & Preamp Calibration tab  
 

 
 

Figure 4.3 
 
2. Click on the Microscope tab.   
 

 
 

Figure 4.4 (Make sure SPM1 is selected in order for the system to communicate 
properly with the PicoLE microscope) 

SPM1 
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3. Select SPM1 as the Microscope Definition File. Enter a default value of ‘400’ into the Incremental 

Range.   
4. Select the Misc. Options tab. Then select the AC Mode Controller Supported box. Click OK to 

accept the changes and close this dialogue. 
 

 
 

Figure 4.5 
 
5. Select Live Scan from the File drop-down menu on the Main Toolbar. 
 

 
 

Figure 4.6 
 
6. Under Mode on the main menu, select AC AFM. 
 

 
 

Figure 4.7 
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7. Under Scanner on the main menu select the scanner calibration file that matches the serial number of 

the scanner being used.  See the diagram below for the location of the serial number. 
 

 
Figure 4.8 

 
 

 
 

Figure 4.9 (Select the calibration file that matches the serial number of the scanner) 
 

 
Tuning the Tip 

8. Under View on the main menu, select AC Mode Controls, then perform the following; 
• Select MAC (as indicated in Figure 4.10 below) to perform a Magnetic AC scan using a MAC tip 
• Select Drive On. 
• Enter 5 for the drive %.   
• Set the Gain to 1x. 
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Figure 4.10 
 
9. Click on the Sweep button.  The AFM AC mode Frequency Plot will now appear.  
 

 
 

Figure 4.11 
 
10. The resonance frequency of the cantilever must be empirically determined by performing a full-scale 

frequency sweep.  
• Select the scale check box directly under the Frequency Range values. 

% Drive 

Sweep 
Button 

MAC Mode 
Selected 
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• Drag the top Frequency slider completely to the right and the bottom Frequency slider completely to 
the left. 

• Click the START button. 
• The Resonance peak indicates the resonant frequency of the cantilever (shown in Figure 4.12 below). 

 

 
 

Figure 4.12 
 
• Zoom in on the resonance peak displayed on the frequency plot by adjusting the two Frequency sliders 

until the resonance peak is centered in the plot.  
• Click on the START button in order to initiate another frequency sweep. 
• Repeat the above procedure until the frequency range of the sweep is less than 10kHz. 
• If off scale, use the software controls to reset the drive to a lower value.  If the amplitude is greater 

than 10 volts, the electronics won’t work correctly.   
 
11. Check the Active check box in the Frequency plot window.  See Figure 4.13 below. 
12. Update the drive frequency of the AC Mode control by left clicking slightly to the left of the resonant 

peak maximum. 
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Figure 4.13 
 

13. After the drive frequency has been updated, adjust the drive percentage so that the amplitude, 
displayed on the front of the AC Mode controller box (the hardware unit, not to be confused with the 
AC Mode Controls window in the software), is 5 ±1 volts. 

14. In the Buffer Assignment window, add a buffer by clicking the + button as needed to get three 
buffers. 

 

 
 

Figure 4.14 (Adding buffers to the group) 
 

Set the three buffers to Topograph, Amplitude, and Phase by selecting each from the drop-down 
menu on the tab for each buffer.  Topograph displays the topography of the sample.  Amplitude 
displays the amplitude of the cantilever oscillation at each point.  The microscope tries to keep the 
amplitude constant, so this image shows changes in the sample surface.  Phase displays the phase 
between the cantilever oscillation and the drive signal. 
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15. In the View menu, select Layout Editor. 
 

 
 

Figure 4.15 (Opening the Layout Editor) 
 

Select the option to display three buffers and click OK. 
16. Align the photodiode detector such that the LFM and deflection signals on the microscope display are 

as close to zero as possible.  In other words, center the laser beam on the detector.  See Aligning the 
Photodiode Detector in Chapter 3 of the PicoLE System module for more information. 

 
 

Engaging the Sample 
17. Set the integral (I) gain % to 1.000 and the proportional (P) gain to 0.5 in the Servo tab of the Servo 

Control window. 
18. In this same tab, make sure the Servo Range is set to its maximum value. 
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Figure 4.16 (Servo Control window) 
 

19. Set the Approach Motor Speed to 5 and the stop at value to 0.9 in the Approach tab of the Scan 
and Approach Control window. 

 

 
 

Figure 4.17 
 

Set Servo Range
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20. Press the Approach button.  When the tip reaches an appropriate imaging distance from the surface of 
the sample, the following message appears: 

 

 
 

Figure 4.18 
 

The microscope is now engaged! 
21. Click OK. 

 
Imaging 

22. The Scan and approach Control window should appear with the Scan tab displayed.  If not, click the 
Scan tab to bring it to the front. 

23. Set the desired X and Y scan dimensions then press the Start button. 
24. An image should slowly appear in the Data Buffers window. 
Note: If a blank image appears, the system may have experienced a false engagement, meaning the tip was 
sufficiently deflected to cause the microscope system to begin acquiring data without actually reaching the 
sample.  This can happen with softer tips and with samples in liquid. 

 

 
 

Figure 4.19 
 
Clicking the Adjust box (with the green border) in the Optimizing tab of the Data Rendering window 
will auto-scale the image displayed in the Data Buffers window. 

 
To get continuous scans, uncheck the Single Scan box in the Scan tab of the Scan and Approach 
Control window.  From this tab, the system can be told to always scan up, always scan down or to 
alternate (Toggle) the scan direction. 
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Image Processing 

The following parameters can be adjusted to maximize image quality:   
 
1. Mode (Flattened, Equalized etc., in the Optimizing tab of the Data Rendering window) 
2. Z-Scale   
3. Integral Gain 
4. Proportional Gain 
5. Set point 

 

 
 

Figure 4.20 
 
For the Mode setting, Flattened first order is the best starting choice.  Sometimes second order can 
remove distortions caused by sample bowing. 

 
The Z-Scale adjustment can be set automatically by pressing on the adjustment tab.  A good value for the 
% sensitivity is 5.  Fine adjustments to the Z range can be made either by entering new values or by 
moving the slider below the adjustment tab. 

 
The integral and proportional gain can be used after initial Mode and Z-scale adjustments.  Increasing 
these parameters can sharpen an image.  Decreasing these parameters can remove noise-like distortion 
from an image.  See the PicoScan Software Manual for more details. 
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The Set Point can be adjusted to remove image distortion that results from the tip location relative to the 
surface.  The tip being too high can result in blurry and physically distorted sample.  The tip being too low 
can result in horizontal (scratch like) lines. 
Note: This parameter should be carefully adjusted in small increments as improper adjustments 
can crash the tip! 

 

Other parameters that can be considered for improving image quality: 
 
1.  Scan speed: Sometimes a sample needs to be scanned at a slow rate.  Usually samples can be scanned 
at 2 lines/second. 

 
2.  Rotate adjustment: A large feature off the screen can sometimes distort a sample.  Rotating the scan 
direction can sometimes solve this problem.  This value is in degrees. 

 

 
 

Figure 4.21 
 
Remember to save images with the Save function on the files menu in the data buffers box. 

 
 
 

File Management 
 
T H E  P I C O S C A N  S O F T W A R E  U S E S  S T A N D A R D  W I N D O W S  F I L E  M A N A G E M E N T  D I A L O G S .  
 

To save an image, simply click the Save button in the toolbar of the Data Buffers window or of the 
Spectroscopy or Potentiostat windows.  Save can also be selected from the File drop-down menu in any 
of these windows.  The file name will be what is entered in the filename portion of the Buffer Assignment 
window.  By having the Name++ box checked, the file names will automatically increment (filename01, 
filename02, etc.), placing each saved set of data in a separate file.  If this box is not checked, the previous 
data will continue to be overwritten to the same file.   
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Figure 4.22 

 
If Store is selected, PicoScan will save the buffer data after each scan is done. 
 
Save Data As… is also a choice in any of the above listed locations.  This selection allows you to designate 
a file name for the data.   
 
To retrieve an already saved image, simply open the file by clicking the Open icon or by selecting Open 
from the File drop-down menu. 
Note: Loading saved data automatically places PicoScan into View mode.  You will have to make sure the 
system is in Live Scan mode before acquiring any new data. 
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Chapter 5: AACAFM Tutorial 
 

A strong point of the PicoSPM system is its AC mode capability.  With this mode, one can obtain high-
quality images of soft samples in-situ.  AC mode means that the cantilever oscillates at a controlled 
frequency, and PicoScan measures the resulting amplitude and phase changes as the tip of the cantilever 
interacts with the surface being imaged.  A vibrating piezo crystal in the nose assembly induces the 
cantilever oscillations.  This tutorial will use the PicoLE system in AAC Mode.  A Large scanner and an 
NCH (non-contact high-frequency) cantilever (C ≈ 40 N/m) will be used to image a gold-on-mica 
substrate.  This tutorial should only be done after completion of the AFM tutorial in the PicoLE System 
module.  If the images obtained are of unsatisfactory quality, try using the PicoIC™ isolation chamber.  
This tutorial is written for a system with a PicoLE microscope and an AC Mode Controller.  For a different 
system configuration, refer to the original AC Mode manual for details. 
 

Hardware 
♦ AC Mode controller 
♦ AFM scanner 
♦ Acoustic AC Nose Assembly 
♦ AAC Cantilever 
♦ Tweezers 
♦ Sample 
♦ Two-sided tape 
♦ Photodiode detector 

 
 

System Setup 
 

Hardware Setup 
Set up the microscope as detailed in the PicoLE System module.  Make the hardware connections that 
are described in Chapter 1: Initial Setup (page 3) of this module.  The Contact/AC Mode/CS AFM 
Switch on the PicoLE Head Electronics Box should be turned to AC Mode.  Make sure that an AAC 
nose is placed in the scanner, see Figure 5.1 below.  See the AFM Nose Assembly section in Chapter 3 of 
the PicoLE System module for instruction on placing the nose into the scanner. 
 

 
 

Figure 5.1 (AAC nose) 
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Software Setup 

PicoScan software should have already been installed on the computer.  Use the following steps as a guide 
to become familiar with the system settings required to make good images. 
 
1. Click View on the main menu bar and select Setup (Scanner, Controller etc.). 
 

 
 

Figure 5.2 
 
The setup dialog will open to the Scanner & Preamp Calibration tab  
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Figure 5.3 
 
2. Click on the Microscope tab.   
 

 
 

Figure 5.4 (Make sure SPM1 is selected in order for the system to communicate 
properly with the PicoLE microscope) 

 
3. Select SPM1 as the Microscope Definition File. Enter a default value of ‘400’ into the Incremental 

Range.   

SPM1 
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4. Select the Misc. Options tab. Then select the AC Mode Controller Supported box. Click OK to 

accept the changes and close this dialogue. 
 

 
 

Figure 5.5 
 
5. Select Live Scan from the File drop-down menu on the Main Toolbar. 
 

 
 

Figure 5.6 
 
6. Under Mode on the main menu, select AC AFM. 
 

 
 

Figure 5.7 
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7. Under Scanner on the main menu select the scanner calibration file that matches the serial number of 

the scanner being used.  See Figure 5.8 below for the location of the serial number. 
 

 
Figure 5.8 

 
 

 
 

Figure 5.9 (Select the calibration file that matches the serial number of the scanner) 
 

 
Tuning the Tip 

8. Under View on the main menu, select AC Mode Controls, then perform the following; 
• Select AAC (as indicated in Figure 4.10 below) to perform a Acoustic AC scan using an AAC tip 
• Select Drive On. 
• Enter 5 for the drive %.   
• Set the Gain to 1x. 
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Figure 5.10 
 
9. Click on the Sweep button.  The AFM AC mode Frequency Plot will now appear.  

 

 
 

Figure 5.11 
 
10. The resonance frequency of the cantilever must be empirically determined by performing a full-scale 

frequency sweep.  
• Select the scale check box directly under the Frequency Range values. 

% Drive 

Sweep 
Button 

AAC Mode 
Selected 
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• Drag the top Frequency slider completely to the right and the bottom Frequency slider completely to 
the left. 

• Click the START button. 
• The Resonance peak indicates the resonant frequency of the cantilever (shown in Figure 5.12 below). 

 

 
 

Figure 5.12 
 
• Zoom in on the resonance peak displayed on the frequency plot by adjusting the two Frequency sliders 

until the resonance peak is centered in the plot.  
• Click on the START button in order to initiate another frequency sweep. 
• Repeat the above procedure until the frequency range of the sweep is less than 10kHz. 
• If off scale, use the software controls to reset the drive to a lower value.  If the amplitude is greater 

than 10 volts, the electronics won’t work correctly.   
 
19. Check the Active check box in the Frequency plot window.  See Figure 5.13 below. 
20. Update the drive frequency of the AC Mode control by left clicking slightly to the left of the resonant 

peak maximum. 
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Figure 5.13 
 

21. After the drive frequency has been updated, adjust the drive percentage so that the amplitude, 
displayed on the front of the AC Mode controller box (the hardware unit, not to be confused with the 
AC Mode Controls window in the software), is 5 ±1 volts. 

22. In the Buffer Assignment window, add a buffer by clicking the + button as needed to get three 
buffers. 

 

 
 

Figure 5.14 (Adding buffers to the group) 
 

Set the three buffers to Topograph, Amplitude, and Phase by selecting each from the drop-down 
menu on the tab for each buffer.  Topograph displays the topography of the sample.  Amplitude 
displays the amplitude of the cantilever oscillation at each point.  The microscope tries to keep the 
amplitude constant, so this image shows changes in the sample surface.  Phase displays the phase 
between the cantilever oscillation and the drive signal. 
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23. In the View menu, select Layout Editor. 
 

 
 

Figure 5.15 (Opening the Layout Editor) 
 

Select the option to display three buffers and click OK. 
24. Align the photodiode detector such that the LFM and deflection signals on the microscope display are 

as close to zero as possible.  In other words, center the laser beam on the detector.  See Aligning the 
Photodiode Detector in Chapter 3 of the PicoLE System module for more information. 

 
 

Engaging the Sample 
25. Set the integral (I) gain % to 1.000 and the proportional (P) gain to 0.5 in the Servo tab of the Servo 

Control window. 
26. In this same tab, make sure the Servo Range is set to its maximum value. 
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Figure 5.16 (Servo Control window) 
 

19. Set the Approach Motor Speed to 5 and the stop at value to 0.9 in the Approach tab of the Scan 
and Approach Control window. 

 

 
 

Figure 5.17 
 

Set Servo Range
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25. Press the Approach button.  When the tip reaches an appropriate imaging distance from the surface of 
the sample, the following message appears: 

 

 
 

Figure 5.18 
 

The microscope is now engaged! 
26. Click OK. 

 
Imaging 

27. The Scan and approach Control window should appear with the Scan tab displayed.  If not, click the 
Scan tab to bring it to the front. 

28. Set the desired X and Y scan dimensions then press the Start button. 
29. An image should slowly appear in the Data Buffers window. 

 
Note: If a blank image appears, the system may have experienced a false engagement, meaning the tip was 
sufficiently deflected to cause the microscope system to begin acquiring data without actually reaching the 
sample.  This can happen with softer tips and with samples in liquid. 

 

 
 

Figure 5.19 
 

Clicking the Adjust box (with the green border) in the Optimizing tab of the Data Rendering window 
will auto-scale the image displayed in the Data Buffers window. 

 
To get continuous scans, uncheck the Single Scan box in the Scan tab of the Scan and Approach 
Control window.  From this tab, the system can be told to always scan up, always scan down or to 
alternate (Toggle) the scan direction. 
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Image Processing 

The following parameters can be adjusted to maximize image quality:   
 
6. Mode (Flattened, Equalized etc., in the Optimizing tab of the Data Rendering window) 
7. Z-Scale   
8. Integral Gain 
9. Proportional Gain 
10. Set point 

 

 
 

Figure 5.20 
 
For the Mode setting, Flattened first order is the best starting choice.  Sometimes second order can 
remove distortions caused by sample bowing. 

 
The Z-Scale adjustment can be set automatically by pressing on the adjustment tab.  A good value for the 
% sensitivity is 5.  Fine adjustments to the Z range can be made either by entering new values or by 
moving the slider below the adjustment tab. 

 
The integral and proportional gain can be used after initial Mode and Z-scale adjustments.  Increasing 
these parameters can sharpen an image.  Decreasing these parameters can remove noise-like distortion 
from an image.  See the PicoScan Software Manual for more details. 
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The Set Point can be adjusted to remove image distortion that results from the tip location relative to the 
surface.  The tip being too high can result in blurry and physically distorted sample.  The tip being too low 
can result in horizontal (scratch like) lines. 
Note: This parameter should be carefully adjusted in small increments as improper adjustments 
can crash the tip! 

 

Other parameters that can be considered for improving image quality: 
 
1.  Scan speed: Sometimes a sample needs to be scanned at a slow rate.  Usually samples can be scanned 
at 2 lines/second. 

 
2.  Rotate adjustment: A large feature off the screen can sometimes distort a sample.  Rotating the scan 
direction can sometimes solve this problem.  This value is in degrees. 

 

 
 

Figure 5.21 
 
Remember to save images with the Save function on the files menu in the data buffers box. 

 
 
 

File Management 
 
T H E  P I C O S C A N  S O F T W A R E  U S E S  S T A N D A R D  W I N D O W S  F I L E  M A N A G E M E N T  D I A L O G S .  
 

To save an image, simply click the Save button in the toolbar of the Data Buffers window or of the 
Spectroscopy or Potentiostat windows.  Save can also be selected from the File drop-down menu in any 
of these windows.  The file name will be what is entered in the filename portion of the Buffer Assignment 
window.  By having the Name++ box checked, the file names will automatically increment (filename01, 
filename02, etc.), placing each saved set of data in a separate file.  If this box is not checked, the previous 
data will continue to be overwritten to the same file.   
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Figure 5.22 

 
If Store is selected, PicoScan will save the buffer data after each scan is done. 
 
Save Data As… is also a choice in any of the above listed locations.  This selection allows you to designate 
a file name for the data.   
 
To retrieve an already saved image, simply open the file by clicking the Open icon or by selecting Open 
from the File drop-down menu. 
Note: Loading saved data automatically places PicoScan into View mode.  You will have to make sure the 
system is in Live Scan mode before acquiring any new data. 
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Chapter 6: ACAFM Procedure 
 

Selecting and Mounting a Cantilever 
 
Choice of an appropriate AFM cantilever is critical to the successful operation of AC Mode AFM.  
Typically cantilevers with spring constant on the order of 1 N/m or higher are used.  Most vendors will 
specify force constant and resonance frequency of their cantilevers; make note of them.  The actual values 
of a cantilever’s force constant and resonant frequency typically vary by 10-15% of the published values. 
 

Mounting the Cantilever 
In ACAFM, mounting of the cantilever is the same as that of contact AFM. 

 
Aligning and Tuning the Cantilever 

 
As previously noted, AC Mode provides the best signal to noise response when the cantilever is oscillated 
at or near its resonance frequency.  It is, therefore, important to become skilled in properly aligning the 
cantilever and identifying the cantilever resonance frequency.  Refer to the tutorial on page 9 if necessary 
for more information.  If using an older MAC Mode Controller, refer to its original manual.  The only 
difference is the software control. 
 

System Setup 
1. Attach all cables as described earlier in this manual. 
2. The AC Mode electronics must be switched on prior to operation.  The power switch can be found on 

the rear panel alongside the power cable. 
3. Ensure that AC Mode and Drive are turned off in PicoScan.  To turn off AC Mode, make sure the 

Contact / AC Mode pulldown menu has Contact selected. 
4. In PicoScan, adjust the Amplitude Setpoint to zero.  The control can be found in the Servo Control 

window of PicoScan. 
5. Using the appropriate AC Mode equipment, set up the microscope as if for a standard AFM experiment 

and align the laser on the apex of the cantilever.  This procedure is described in the AFM chapter of the 
PicoLE System module. 

6. Align the detector in the microscope such that the deflection and LFM signals on the microscope 
electronics box are close to zero.  This procedure is described in the AFM chapter of the PicoLE 
System module. 

 
Tuning the Cantilever 

“Tuning” is a commonly used term referring to the systematic location of the cantilever’s natural resonance 
frequency and the selection of an appropriate driving signal to establish an appropriate oscillation 
amplitude. 

7. The AC Mode Controls window is shown in the tutorial in the preceding chapter.  Set Input Gain to 
x1.  Set Drive to 5%.  Click on the Sweep button.  If imaging in MAC Mode, ensure that the MAC 
Mode sample stage is positioned such that the ferrite core is directly under the cantilever and as close as 
possible without interfering with the free oscillation of the cantilever. 

8. Select an appropriate frequency sweep range for the installed cantilever.  Select Single Sweep and set 
the # Data Points (samples) setting.  The frequency range divided by # Data Points is the resolution. 
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9. Press the START button in the AFM ACMode Frequency Plot window.  The software will perform 
a simple sampling procedure measuring the oscillation amplitude of the cantilever while stepping the 
frequency in the specified range.  The sweep will be displayed in the window. 

10. The resonance response curve, also called the tuning curve, should show a single, sharp peak that 
stands several times taller than the baseline noise.  The height of the peak can be changed by adjusting 
the Drive in the AC Mode Controls window, and the frequency axis can be changed using the 
From/To Frequency controls in the spectroscopy window.  Using these controls and, if necessary, 
increasing Nr Data Points, locate the frequency at which the curve reaches its maximum value.  This is 
the natural resonance frequency of the cantilever.  The ideal imaging frequency is at, or just below, the 
free resonant frequency of the cantilever.  For the best image quality, select either the peak value by 
clicking the Find: Max button just below the active checkbox or manually select a drive frequency 
from the steep slope on the low (left) side of the peak in the frequency sweep.  To select a drive 
frequency, check the active checkbox for the red cursor in the AFM AC Mode Frequency Plot 
window and then click the desired location on the plot.  The resonant frequency may decrease slightly 
when the sample is engaged. 

11. The cantilever’s amplitude is positive and always shown on the AC Mode Controller’s meter.  Switch 
the pulldown menu from Contact to AC Mode to turn on AC Mode.  Adjust Drive in the AC Mode 
Controls window until the display on the MAC box reads between 2.0 and 5.0.  The Amplitude 
Setpoint is the amplitude the servo will maintain when engaged. 

12. In the Scan and Approach Control window, make sure that Stop At: is set to 0.9 V.  The system is 
now ready to approach and image the sample. 

 
Obtaining an Image with AC Mode 

♦ For softer samples, the setpoint will need to be adjusted as necessary to minimize the tip-sample 
interactions.  If the difference between the setpoint and free amplitudes is too great, there is a potential 
for degrading the sample quality (and damaging the tip). 

♦ Approach the probe to the sample surface in the same way as in contact mode AFM and start to image 
after the probe is in range. 

♦ It is important to note that the controller approaches the tip to the sample until the amplitude of the 
cantilever in volts has been decreased to the Amplitude Setpoint voltage. 

♦ Using the amplitude-distance curve to adjust the set point is a good way to optimize imaging 
conditions.  The amplitude is represented by a positive voltage, thus free amplitude is at the top of the 
plot and zero amplitude is at the bottom.  Under normal conditions you should adjust the force set 
point to about 80% of free amplitude.  Again with softer samples this value may need to be adjusted to 
a higher percentage of the free amplitude. 

♦ Typically in AC Mode AFM, it is desirable to use lower gain settings (I, P = 0.3, 0.3) and a slower scan 
rate (2-3 Hz).  Scan rates vary with the stiffness of the cantilever.  The stiffer the cantilever, the more 
quickly the Z-piezo can respond, which allows good image resolution at higher scan rates. 

 
Additional Tips for Magnetic AC Imaging 

If unable to get a good image in MAC Mode, these tips may help: 
 
♦ Place the microscope in a PicoIC with the door closed.  Make sure that there are no significant sources 

of noise in the area. 
♦ Separate all relevant cables so that their magnetic fields will not interact to produce noise.  Also keep 

the cables away from any other power cords or electric devices. 
♦ Handling the microscope can cause thermal instabilities in the system.  Try leaving the microscope 

alone for at least an hour after setting it up to allow the system to reach thermal equilibrium before 
imaging. 
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♦ If unable to find a good resonance peak with the frequency sweep, or if the cantilever drifts away from 
the laser beam, try gluing or otherwise securely fastening the cantilever to the cantilever holder. 

 
Acoustic AC imaging is discussed in-depth in Chapter 8: Advanced Theory. 
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Chapter 7: Troubleshooting 
 

Getting a clear, stable image depends on many parameters.  Having a clean, properly prepared sample and a 
good cantilever are essential to attaining quality images.  There are other factors that play a role in the 
acquisition of quality images. The following tips offer helps in resolving some of the problems encountered 
in MAC mode imaging. 

 

Unable to get clear images after placing a good cantilever 
 

The optimized operation force set point is with in the range ~0.7 to 0.9 of the free amplitude before the tip 
touches the surface of the sample. When the set point is above the shoulder, as shown in Figure 7.1, the 
image will be blurry.  To resolve this problem, gradually lower the set point to bring it below the shoulder. 
Or, as a last resource, an Amplitude vs. Distance curve can be run in order to adjust the set point. 

 

Figure 7.1 (Amplitude vs. Distance curve) 

 

Noisy Amplitude vs. Frequency curve 
 

Occasionally, the Amplitude vs. Frequency curve becomes noisy as shown in the left side of Figure 7.2 
below.  A readjustment of the deflected laser spot will often solve this problem, as shown in the right side 
of Figure 7.2. 
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Figure 7.2 (left: Noisy and right: Clean Amplitude vs. Frequency curves) 
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Chapter 8: Advanced Theory 
 

The following document was written by Chad Rigetti concerning Acoustic Mode ACAFM.  Most of the 
concepts also apply to MAC Mode.  The document contains a wealth of information on the finer points of 
AC Mode imaging.  It is presented as-is on the following pages.  Note that this document was written for 
the PicoSPM I microscope. 
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